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MICROSOFT EXCEL 2007-2010 
Cập nhật ngày 9/4/2019 

 

 à     C C            C     C         C    
 

1.  h     ng  à th  t 

1-  h     ng có nh ều c ch.  h  t có nh ều c ch  Close          File > Exit      Ctrl+F4 

 t  át b  k  hay Alt+F4 (thoát   ương trìn  . 

2.         n 
  h nh t  u  ề 
  h nh th       n   h    nh       n    n g  Ctrl+F1 

  h nh     ch   à c ng th c:     t n      n t             ng t  c  t n          g    t n   t    t n   ng     

        t            t        ng     

    th ng      n 
-   á        r        t      t    Formulas    Data. 

   ng             u có  
-   ng  á  t         t  t                t           t   

-   t   t t         ng  t      n          

 Thanh c c th   h  t   ướ    y :     t       t            t       t n     tn t  n  t n g   n         ng    

t      n t      t [   ]     t            t [   ]     t     t       t      t n     ng     t k á        ng    

t           n  k   t      t     t      ng    tr  k á  tr n t  n   á  t  . 

  h nh t  ng th  . 
 

 à                  C                   
 

1.    n th     ng t nh  
 

1-      n b n      File > New > Create >              Blank WorkBook h ặc Ctrl+N. 
WorkBook         Q   n    k  t án    n WorkSheet      t b ng t n .  r ng     n             t        ng 

    n     WorkBook.  
2-      n b n            á             n b n      ng n   t ì k    ư  tr      n    n     ng     

3-        n b n  b t     g        t  á     ng  á       Enter, Shift, CapsLock,        t     ng n t 

Undo hay Redo n ư Word.               t n ư Word. 

4- T   t     t        n   n    ng (France (Belgium))    nư   (Viet Nam) qua Control Panel. 

         t            k  ng   ng t       g                  n     n     ng   n   t     t   n á  

                  n     ơn     k  ng   ng t       ng b n      k t         t         

       ng          t     n  á      á    ng         n      t     n        t          n   n  r      n 

 á            n    ng       ng         

 á  n     ng   n b n t    ng     t k t         b n             g  ng n ư tr ng Word. 

5-    n   ng   ư          n ư tr ng Word.   ng t n              ng     n     *.xlsx    n  ư  tr ng  á      n 

b n       *.xls.       t     t       t k          t        t   ư                 t     ìn    t n ư Word. 
 

 h c hành 1:    nh   ch h c   nh  ớp   n  
 

       C   ỌC       Ớ       ỌC 

STT     à t n     nh Đ  n th    Đ   ch       ình 

1  g  ễn        n Anh        ng 0240872091        tt     ng           

2  g  ễn   n   ư ng        ng  0240881601  g     ồ  L    g n 

3   n   g    Đ c       n  0241776256  ìn    n   Lương     

Yêu cầu:: 

       t   r  t          t    t     t t    t   t  t n        t     t t    t   t        n t     t ng   n       n k  

k  ng n ư     
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 h c hành    (  ng k  ch  ph  hàng hó  nhập  
         

Stt   n hàng     ượng Đơn g    hành t ền  h   ận t    huế nhập  ổng ch  ph   ỷ    % 

1 P ân k    5 50           

2 Ca cao 6 60           

3     t n  t n  4 70           

4 P ân  ơ  2 60           

5     k   11 90           

 

Yêu cầu: 

   n  t  n =     ư ng *  ơn g á. P     n t   =  % *    n  t  n.      n    =  % *    n  t  n.  

 ỷ       = b   n     %        t ng   ng              á    t   ng.  

           r        t n            t      n   ng         t t    t ng      g      n   

 

 h c hành    (  ng th    õ  thu nhập  
       

STT      n       

 ương 

 hu nhập  huế thu nhập Chú th ch 

1  ương  ồng   nh 4,15    

2  g  ễn Q  ng Minh 1,75    

3  g  ễn P ương Linh 0,25    

4  g  ễn       ền 2,92    

5 Lương  ân Ly 3,75    

 

Yêu cầu: 

Lương  ơ b n = 40000.  

Ng     ng n   =  9   

    n     =        ương *  g     ng n   * Lương  ơ b n      tr n   n   ng ng n  

     t   n    =   % *      n    –        *    n       n     >        *    trá      t ì =    

           r        t n            t      n         t t         t   n     g      n   
 

 h c hành 4:       phương t ình  ậc h     
2
 + bx + c = 0) 

 

STT a b c delta    ngh  m 

1 20 13 12   

2 13 4 0   

3 1 7 12   

4 -5 -1 1   

5 1 4 4   

 

Yêu cầu: 

P      ng   ng t    t n     t          f      ư  r  k t    n       ng     .  
 

Th c hành 5:  Qu n    kh ch   n  h  n  ân L          k ng          k ng          k ng  ) 

STT H  t n kh ch       ừ ngày Đến ngày 
   

ngày 

Đơn 

g    
  ền thu  

1  g  ễn    ng  uy n  A 13/01/98 19/01/98      

2  r n          ằng B 11/02/98 19/02/98      

3    Lâ  Nhung C 20/02/98 28/02/98      

4  g  ễn     Sang A 03/03/98 09/03/98      
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 h c hành 6:     ng    m h c k    –    à c  năm  
 

stt H  và t n hs1 hs2 hs2 thi tbkt HK1  ết qu  

1 Lý Q ỳn   Anh   9 9         

2 Nguyễn Q ỳn  Anh    7 10         

3     râ   Anh   8 8         

4        n  Anh   8 9         

5 Tr n Quang  B ch   9 8         

6 Nguyễn Minh Châu   7 9         

7 Ly Phương Chi   8 8         

8 Nguyễn        n   Dung   8 8         

9  g  ễn    n   ũng   10 9         

10          ương  Giang   8 9         

11  rương      Giang   8 9         

 

Yêu cầu: 

             =    n ỏ  ơn tr ng                      n   

     t   =        n  ơn tr ng                          

     tbkt = tr ng bìn  k    tr            tương  ng  

         =  tbkt*  + thi)/3. 

  t q   = “  ỏ ” n       ≥    “ r ng bìn ” n        ≥        n        “   ”  

L   t    r    t     t n           t    t   t       t         ng t     

 
 

stt  ä  µ tªn HK1 hs1 hs2 hs2 thi tbkt HK2 TBCN     t   

1 Lý Q ỳn   Anh    8 8          

2 Nguyễn Q ỳn  Anh     9 8          

3     râ   Anh    8 8          

4        n  Anh    7 8          

5 Tr n Quang  B ch    10 9          

6 Nguyễn Minh Châu    9 8          

7 Ly Phương Chi    9 8          

8 Nguyễn        n   Dung    8 8          

9 Ngu ễn    n   ũng    8 8          

10          ương  Giang    8 9          

11  rương      Giang    7 10          

 
Hà Nội, ngày 12/4/2018 

Chủ nhiệm lớp 

 
Nguyễn Thị Hồng Diệp 

Yêu cầu:  

             =    n ỏ  ơn tr ng                      n).      t   =        n  ơn tr ng                          

     tbkt = tr ng bìn  k    tr            tương  ng           =  tbkt*  + t       

          =       * +                          t         n      ng   P  t      b  t   

L   t    r    t     t n              bằng  án  g á t  n b      t  t      “   n b  n        >       “   t 

   ” n        <         n     t ì k  ng    t gì     
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 h c hành 7: ( ập   ng c u chương) 
 

 
1 2 3 4 5 6 7 8 9 

1 1 2 3 4 5 6 7 8 9 

2 2 4 6 8 10 12 14 16 18 

3 3 6 9 12 15 18 21 24 27 

4 4 8 12 16 20 24 28 32 36 

5 5 10 15 20 25 30 35 40 45 

6 6 12 18 24 30 36 42 48 54 

7 7 14 21 28 35 42 49 56 63 

8 8 16 24 32 40 48 56 64 72 

9 9 18 27 36 45 54 63 72 81 

  

Yêu cầu: 

            n      t      rồ    ng     t q  t       t b ng  
 

 h c hành 8: (  ng thu t ền    n th ng 6/ 0 4) 
         

STT    t n chủ h  
Ch     

cũ 

Ch     

mớ  

Đơn 

g   

 hành 

t ền 
 h t C ng 

1  g     n Quyết 75 535         

2  g  ễn        nh   456 520         

3  g  ễn     Thanh 281 642         

4  g  ễn      uyền 655 705         

5 P  n       nh 254 389         

6    ng      uyết 570 950         

7  g  ễn      húy 898 910         

8        Toan 638 755         

9 P  ng     Nga 244 375         

10  r n           g c 346 755         

11            n  hương 763 495         

12   ãn      hượng 432 600         

 

Chú ý: 

 ơn g á =      k      n  t  n =             –           * ơn g á  

          >     t ì    t    %         n  t  n    rá      n   >     t ì    t   %         n  t  n  

  n     t ì t    k  ng    t gì     

L   t          t n        t t    t   t    n                      t t    t   t    ng       g      n . 
 

 h c hành 9: (  ng    m th  hk  năm h c  00  - 2004) 

BẢNG ĐIỂM THI HỌC KỲ II NĂM HỌC 2001 - 2002 

STT 
Họ và tên 
học sinh 

Điểm các môn 

Tổng  
Điểm  
TB 

Vị 
thứ 

Xếp  
loại 

Văn Toán 
L   ị   c  
h  
sử 

N g o  ạ i  
ngữ 

2 3 2 2 

1 Anh 10 5 8 9 69 7,67 3 B 

2 Âu 9 6 7 8 66 7,33 5 B 

3 Bình 5 10 8 9 74 8,22 2 B 

4 Đại 8 7 6 7 63 7,00 6 B 

5 Dũng 7 5 6 7 55 6,11 7 C 

6 Giang 4 8 5 6 54 6,00 8 C 
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7 Hùng 6 5 4 4 43 4,78 10 D 

8 Hương 8 9 9 7 75 8,33 1 B 

9 Văn 7 7 10 7 69 7,67 3 B 

10 Yến 5 4 8 5 48 5,33 9 C 

  Điểm trung bình cao nhất 8,33 

  Điểm trung bình thấp nhất 4,78 

  Tổng số học sinh xếp loại A 0 

  Tổng số học sinh xếp loại B 5 

  Tổng số học sinh xếp loại C 3 

  Tổng số học sinh xếp loại D 1 

 
Yêu cầu:  

           á    n rồ  t n  t án    á      n      

P  n            

   ≥ 9 t ì                ≥   t ì       ≥   t ì      n                

 

 h c hành 10: (  ng t nh t ền    n  

BẢNG TÍNH TIỀN ĐIỆN 

STT 
Khách  
hàng 

Khu 
vực 

Số  
cũ 

Số  
mới 

Định  
mức 

Tiêu  
thụ 

Tiền  
điện 

Thuê  
bao 

Phải  
trả 

1 Nguyên 3 436 630       150        194      102.700          5.135          107.835  

2 Minh 2 307 450       100        143        79.400          3.970           83.370  

3 Dũng 3 410 509       150          99        44.550          2.228           46.778  

4 Miên 2 160 230       100          70        31.500          1.575           33.075  

5 My 1 171 205         50          34        15.300            765           16.065  

6 Nam 1 468 500         50          32        14.400            720           15.120  

Tổng cộng         

 
Yêu cầu:  

         t                         rồ  t n    

            n             k           n                k           n               

   n    n   

          ≤   n      t ì        g á           

trá                 ư t      ơn g á             tr ng       n              

     b       %    n    n   

P    tr  bằng    n    n +      b    

 

 h c hành  1    hu  ổ  ng    t   

BẢNG TỔNG HỢP NGOẠI TỆ THU ĐỔI TRONG NGÀY 

Loại  
NT 

Tỷ giá 
Tổng  
số  

STT Khách hàng 
Ngoại  
tệ 

Loại  
NT 

Tiền VND 

AUD         7.480   
 

1 Nam       2.000  USD  

DEM         6.346   
 

2 Hà          600  FRF  

FRF         1.892   
 

3 Dũng          800  GPB  

GPB       20.308   
 

4 Nguyên          900  USD  

JPY            120   
 

5 Thảo            50  JPY  

USD       14.611   
 

6 My          700  DEM  

      
 

7 Dung          125  USD  

    
8 My       1.000  CHD  

         Yêu cầu:  

     ng  á      : VLOOKUP(H3,$A$3:$B$8,2,0)*G3 và SUMIF($H$3:$H$9,"USD",$I$3:$I$9) 
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  n    t t  n    t    t  n ng    t  *  ỷ g á t ng         n  t ng    t  n  g    t  t ng ng   t    t ng     . 

 h c hành  2    h nh t  n t ền  ương  – HLOOKUP 

 

 
B C D 

  

 
      

  

 
200000 100000 50000 

  

      TT Ho ten Loai So cong Tien   

1 Tuan  A 28 #N/A A không có trong hàng trên  

2 Anh C 25 2500000   

3 Hung D 17 850000 D>C  se lay gia tri cuoi la 50000 

4 Thanh B 27 5400000   

Tính lương của các công nhân theo loại A,B,C,D biết bảng lương ở đâu đó  
HLOOKUP(lookup_value,table_array,index_num,[range_lookup]) 

Hàm HLOOKUP(x,Bảng,Cột tham chiếu,Cách dò) 

Trong đó, x là ô khóa dò, ví dụ: C8 (Loại của công nhân Tuấn) 

Bảng là bảng mẫu (barem), bảng lương quy định ví dụ: $B$2:$D$4 

Hàng tham chiếu là hàng cho giá trị tương ứng để tính toán tiếp, Hàng số 3 của Bảng 

Trường hợp Cách dò = 1: Hàng bên trên của Bảng phải tăng dần, nghĩa là: 

Nếu x < Phần tử đầu thì cho #N/A 
Nếu x > Phần tử cuối cùng thì lấy giá trị tham chiếu cuối cùng 

Trường hợp Cách dò = 0 thì Hàng bên trên không nhất thiết phải theo thứ tự tăng dần. 

Chỉ khi nào x trùng với phần tử nào đó của hàng bên trên thì mới cho giá trị tham chiếu 

Trái lại sẽ là #N/A (Not Available) 

            

TT Ho ten Loai So cong Tien   

1 Tuan  A 28 #N/A A không có trong hàng trên  

2 Anh C 25 2500000   

3 Hung E 17 #N/A E không có trong hàng trên  

4 Thanh B 27 5400000   

 

2.  n h  n c c c t/hàng th     mình 
-       n  á    t   ng   n  n    n  n á                 n              n    n r  t  b     n   ng k   ng    n  

chon Unhide. 

-       n  á    t   ng   n     >   ng   ễ        t    ât n      rt      t r    á    án      k              n 

   n bỏ     k              k  ng   n    n  

-  ì  k    t      t   ng        n   t >   n  > g  t  k    >   n     t      t   k   t    t    t    
 

3.    n  ch t ếng    t ch    c    007 t     n 
    tr ng http://khoia0.com        n     n,   k            k           n  Excel 2007-2010,  t   f    

TVEXCEL.xla     ư      f    r C:\Program Files\Microsoft Office.           Excel >       n  File > Excel 

Options > Add-ins > Go > Browse >   n   n C:\Program Files\Microsoft Office, k    f    TVEXCEL.xla rồ  

OK     t       -ins tr n t  n  t   Ribbon. 

    n     n tá   g         t             n                á    n        t        t ì    n  á      tư ng    

n á      t      - n  >   á             ng    t b n trá      n   ng      tương  ng.  ã  t   ng     ng    

 

4. Qu n h  g    Excel  à c c phần kh c củ   ff c  
-       t          t    n             t     E       ng  án       r     ngư          ng    t    án     

P w rP  nt n     r ng E       n n     r t     n ư b     ồ   ẳng   n      b  t  r n   n b n r t hay!  

-   n        g   tì  t            ỏ  t       
 

lightsmok@gmail.com 

http://khoia0.com/

